	TRƯỜNG TIỂU HỌC BÌNH LÃNG

Họ và tên: ……………………………
Lớp: 3….
	BÀI KIỂM TRA ĐÁNH GIÁ HỌC SINH CUỐI HK I

Năm học: 2020 - 2021
Môn: Tin học - Lớp 3
Thời gian: (40 phút không kể thời gian giao đề)



	
	


A. LÝ THUYẾT (4 điểm)
Khoanh tròn vào chữ cái trước câu trả lời đúng (từ câu 1 đến câu 7)

Câu 1: (0,5đ). Để thoát máy tính em nhấn phím [image: image1.png]


, sau đó nháy chuột chọn:
	A. Restart.
	B. Shut down
	C. Sleep
	D. Log off


Câu 2: (0,5đ). Chỉ ra 8 phím xuất phát ở hàng cơ sở:

A. 
A S D F J K L ;

B.
 A S D F G J K L ;
C. 
A S D F H J K L ;
D. 
A S D F G H J K
Câu 3: (0,5đ). Đâu là các biểu tượng của trình duyệt Web?
	A. [image: image2.png]



	B. [image: image3.png]



	C. [image: image4.png]



	D. Cả A và C




Câu 4: (0,5đ). Để lưu bài vẽ có sẵn trong phần mềm Paint, em nháy chọn [image: image5.png]


 ở phía trên góc trái phần mềm Paint, rồi chọn:
	A. New
	B. Print
	C. Save
	D. Open


Câu 5: (0,5đ) Để Sao chép hình vẽ em chọn phần hình vẽ sau đó sử dụng công cụ:

A. 

[image: image6.png]33 copy



 và 
[image: image7.png]Paste




B. 

[image: image8.png]33 copy



 và [image: image9.png]



C. 

[image: image10.png]Paste



 và 
[image: image11.png]33 copy




D. 
[image: image12.png]


 và 
[image: image13.png]Paste




Câu 6: (0,5 đ). Để vẽ đoạn thẳng nằm ngang nằm ngang hay thẳng đứng em nhấn giữ phím nào sau đây khi thực hiện kéo thả chuột:
	A. Ctrl
	B. Shift
	Enter
	Alt


Câu 7: (0,5đ). Để xóa thư mục em nháy nháy chuột lên thư mục muốn xóa, sau đó nhấn phím:

	A. Delete
	B. Enter
	C. Shift
	D. Ctrl


Câu 8: (0,5đ). Sắp xếp theo thứ tự các bước để tạo thư mục KHOI 3 trên màn hình nền


- Bước…… : Nháy chọn New rồi chọn folder.


- Bước……  : Gõ tên thư mục có tên KHOI 3 vào ô New Folder rồi nhấn Enter


- Bước…… : Nháy nút phải chuột lên màn hình nền
B. THỰC HÀNH (6  điểm ) 
Câu B.1 (3.5đ): Sử dụng phần mềm Paint và các công cụ đã học và công cụ có sẵn để vẽ hình chiếc ô tô.

[image: image14.png]



Câu B.2(1 đ): Trang trí thêm các chi tiết trong xe
Câu B.3 (1 đ): Lưu bài vào thư mục với tên: bai ve  ky 1
MA TRẬN BÀI KIỂM TRA CUỐI HỌC KỲ I

Môn: Tin học - Lớp 3
Năm học: 2020 – 2021
1. Ma trận số lượng câu hỏi và điểm.
	Mạch

 kiến thức – kỹ năng
	Số câu/ số điểm
	Mức 1
	Mức 2
	Mức 3
	Mức 4
	Tổng điểm và tỉ lệ %

	
	
	TN
	TL/

TH
	TN
	TL/

TH
	TN
	TL/

TH
	TN
	TL/

TH
	Tổng
	TL


	1. Làm quen với máy tính
	Số câu
	2
	
	1
	
	
	
	
	2
	5
	

	
	Số điểm
	1.5
	
	0.5
	
	
	
	
	1.5
	3.5
	35

	2. Em tập vẽ
	Số câu
	2
	
	2
	
	
	1
	
	1
	6
	

	
	Số điểm
	1,5
	
	1
	
	
	3.5
	
	1.5
	6,5
	65

	Tổng
	Số câu
	4
	
	3
	
	
	1
	
	3
	11
	

	
	Số điểm
	3
	
	1.5
	
	
	3.5
	
	3
	10
	100%

	
	Tỉ lệ
	30%
	
	15%
	
	
	35%
	
	30%
	100%
	


2. Tương quan giữa lí thuyết và thực hành:
	
	Số câu
	Điểm
	Tỉ lệ

	Lí thuyết (20')
	8
	4
	40 %

	Thực hành (20')
	3
	6
	60 %


ĐÁP ÁN BÀI KIỂM TRA CUỐI HỌC KỲ I

Môn: Tin học - Khối 3
Năm học: 2020 - 2021
	Câu
	Đáp án
	Điểm

	A. Lý thuyết

	Câu 1
	B
	0.5 điểm

	Câu 2
	A
	0.5 điểm

	Câu 3
	D
	0.5 điểm

	Câu 4
	C
	0.5 điểm

	Câu 5
	A
	0.5 điểm

	Câu 6
	B
	0.5 điểm

	Câu 7
	A
	0.5 điểm

	Câu 8
	- Bước 2:
- Bước 3:

- Bước 1
	0.5 điểm

	B. Thực hành

	Câu B.1


	- Vẽ được hình chiếc ô tô
	3.5 điểm

	Câu B.2
	- Trang trí thêm các chi tiết theo mẫu



	1.5 điểm



	Câu B.3
	- Lưu được bài vào thư mục


	1 điểm


	TRƯỜNG TIỂU HỌC BÌNH LÃNG

Họ và tên: ……………………………
Lớp: 4….
	BÀI KIỂM TRA ĐÁNH GIÁ HỌC SINH CUỐI HK I

Năm học: 2020 - 2021
Môn: Tin học - Lớp 4
Thời gian: (40 phút không kể thời gian giao đề)



	
	


A. LÝ THUYẾT (4 điểm)
Khoanh tròn vào chữ cái trước câu trả lời đúng (từ câu 1 đến câu 7)

Câu 1: (0,5đ). Để xóa thư mục, em thực hiện:

A. Nháy phải chuột lên thư mục cần đổi tên, chọn Copy
B. Nháy phải chuột lên thư mục cần đổi tên, chọn Delete.

C. Nháy chuột lên thư mục cần đổi tên, sau đó nhấn phím F2 trên bàn phím.

D. Nháy phải chuột lên thư mục cần đổi tên, chọn Cut
Câu 2: (0,5đ). Để truy cập được Internet, máy tính phải:

A. Có chương trình soạn thảo văn bản.


B. Có trình duyệt Internet.


C. Được kết nối với mạng Internet và có các trình duyệt Web


C. Không cần kết nối với mạng Internet, chỉ cần có các trình duyệt Web.
Câu 3: (0,5đ). Chỉ ra công cụ sao chép màu:
	A. 
[image: image15.png]



	B. 
[image: image16.png]



	C. 
[image: image17.png]



	D. 
[image: image18.png]





Câu 4: (0,5đ). Để lưu hình ảnh trên trang tìm kiếm, em nháy phải chuột vào hình ảnh cần lưu và chọn:


A. Lưu hình ảnh thành.


B. Sao chép hình ảnh


C. Lưu liên kết thành.


D. Sao chép địa chỉ hình ảnh.
Câu 5: (0,5đ). Các thông tin dữ liệu trên máy tính có thể lưu trữ ở:

A. Thiết bị lưu trữ USB


B. Ổ cứng.


C. Đĩa CD/DVD 


D. Tất cả các thiết bị trên
Câu 6: (0,5đ). Để chọn toàn bộ bài vẽ, em sử dụng tổ hợp phím:
	A. Ctrl + A
	B. Ctrl + C
	C. Ctrl + S
	D. Ctrl + V


Câu 7: (0.5 đ). Trong phần mềm soạn thảo Word, để chèn tranh/ảnh em thực hiện:

A. Insert/Table

B. Insert/Picture

C. Insert/Shapes

D. Insert/Chart
Câu 8: (0.5 đ). Nối các biểu tượng ở cột A với các nội dung ở cột B để được câu đúng:
	A
	
	B

	
[image: image19.png]Ngoi nha.png




	
	Tệp của phần mềm Word

	
[image: image20.png]



	
	Tệp của phần mềm Paint

	
[image: image21.png]Tap huan.pptx




	
	Tệp của phần mềm trình chiếu Powerpoint


B. THỰC HÀNH (6  điểm ) 
Câu B.1(3,0 điểm): Khởi động phần mềm vẽ Paint sử dụng các công cụ đã học vẽ hình theo mẫu sau:
[image: image22.png]



- Lưu bài vào thư mục với tên Bài 1 ky 1
Câu B.2.1 (2 đ): Soạn thảo và trình bày văn bản theo mẫu sau:

Câu B2.2 (1 điểm): Tạo đường viền và màu nền cho hình nhãn vở sao cho đẹp.

- Lưu vào thư mục với tên Bai 2 ky 1
MA TRẬN BÀI KIỂM TRA CUỐI HỌC KỲ I

Môn: Tin học - Lớp 4
Năm học: 2020 – 2021
1. Ma trận số lượng câu hỏi và điểm.
	Mạch

 kiến thức – kỹ năng
	Số câu/ số điểm
	Mức 1
	Mức 2
	Mức 3
	Mức 4
	Tổng điểm và tỉ lệ %

	
	
	TN
	TL/

TH
	TN
	TL/

TH
	TN
	TL/

TH
	TN
	TL/

TH
	Tổng
	TL



	1. Khám phá máy tính
	Số câu
	3
	
	1
	
	1
	
	
	
	5
	

	
	Số điểm
	1.5
	
	0,5
	
	0.5
	
	
	
	2.5
	25%

	2. Em tập vẽ
	Số câu
	1
	
	1
	
	
	1
	
	
	3
	

	
	Số điểm
	0.5
	
	0.5
	
	
	3
	
	
	4
	40%

	3.Soạn thảo văn bản
	Số câu
	1
	
	
	
	
	
	
	2
	3
	

	
	Số điểm
	0.5
	
	
	
	
	
	
	3
	3.5
	35%

	Tổng
	Số câu
	5
	
	2
	
	2
	
	2
	11
	

	
	Số điểm
	2.5
	
	1
	
	3
	
	3
	10
	100%

	
	Tỉ lệ
	25%
	
	10%
	
	35%
	
	30%
	100%
	


2. Tương quan giữa lí thuyết và thực hành:
	
	Số câu
	Điểm
	Tỉ lệ

	Lí thuyết (20')
	8
	4
	40 %

	Thực hành (20')
	3
	6
	60 %


ĐÁP ÁN BÀI KIỂM TRA CUỐI HỌC KỲ I

Môn: Tin học - Khối 4
Năm học: 2020 - 2021
	Câu
	Đáp án
	Điểm

	A. Lý thuyết

	Câu 1
	B
	0.5 điểm

	Câu 2
	C
	0.5 điểm

	Câu 3
	B
	0.5 điểm

	Câu 4
	A
	0.5 điểm

	Câu 5
	D
	0.5 điểm

	Câu 6
	A
	0.5 điểm

	Câu 7
	B
	0.5 điểm

	Câu 8
	- Tệp của phần mềm Paint 
[image: image23.png]Ngoi nha.png




- Tệp của phần mềm Word 
[image: image24.png]



- Tệp của phần mềm trình chiếu Powerpoint 
[image: image25.png]Tap huan.pptx





	0.5 điểm

	B. Thực hành

	Câu B.1
	- Vẽ được hình chiếc bánh sinh nhật
	2 điểm

	
	- Trang trí



	0.5 điểm

	
	- Tô màu
	0.25 điểm

	
	- Lưu bài
	0.25

	Câu B.2.1
	- Soạn thảo văn bản theo mẫu
	2 điểm

	Câu B.2.1
	- Chọn được màu nền và màu đường viền

- Lưu bài vào thư mục
	0.75 điểm
0.25 điểm


	TRƯỜNG TIỂU HỌC BÌNH LÃNG

Họ và tên: ……………………………
Lớp: 5….
	BÀI KIỂM TRA ĐÁNH GIÁ HỌC SINH CUỐI HK I

Năm học: 2020 - 2021
Môn: Tin học - Lớp 5
Thời gian: (40 phút không kể thời gian giao đề)



	
	


A. LÝ THUYẾT (4 điểm)
Khoanh tròn vào chữ cái trước câu trả lời đúng.

Câu 1: (0,5đ). Chỉ ra địa chỉ thư điện tử có cấu trúc hợp lệ:
A. susumaiphuong*@gmail.com
B. susumaiphuong@gmail.com
C. su su mai phuong@gmail.com

D. susumaiphương@gmail.com 
Câu 2: (0,5đ) Khi gửi thư điện tử có đính kèm tệp tin, em nháy chuột vào:

	A. 
[image: image26.png]



	B. 
[image: image27.png]



	C. 
[image: image28.png]



	D. 
[image: image29.png]





Câu 3: (0,5đ). Em hãy chỉ ra biểu tượng cỡ nhỏ trong ngăn bên phải?
A. 
[image: image30.png]


 Small Icons
B. 
[image: image31.png]


 Extra Large Icons
C. 
[image: image32.png]


 Large Icons
D. 
[image: image33.png]BB



 List
Câu 4: (0,5đ). Trong Microsoft Word, để đánh số trang vào phía dưới của trang em thực hiện theo trình tự? 

A. Insert → Page Numbe → Top of page
B. Insert → Page Number  → Botton of page  
     

C. Page Layout →  Margins    
D. Page Layout → Orientation
Câu 5: (0,5đ). Để tạo đường viền cho văn bản em chọn thẻ Page Layout sau đó nháy chọn:
	A. 
[image: image34.png]



	B. 
[image: image35.png]Page
Color~




	C. 
[image: image36.png]



	D. 
[image: image37.png]





Câu 6: (0,5đ). Để chèn âm thanh vào bài trình chiếu, em chọn nút lệnh nào trong thẻ Inert?

	A. 
[image: image38.png]



	B. 
[image: image39.png]AAAAA




	C. 
[image: image40.png]T

Equation




	D. 
[image: image41.png]Symbol






Câu 7: (0,5đ). Trong Microsoft PowerPoint hiệu chuyển động là nút lệnh:


A. Nút lệnh ngôi sao màu trắng [image: image42.png]7% Motion Paths



 

B. Nút lệnh ngôi sao màu đỏ
[image: image43.png]


      

C. Nút lệnh ngôi sao màu xanh
[image: image44.png]Entrance



      

D. Nút lệnh ngôi sao màu vàng  [image: image45.png]



Câu 8: (0,5đ).  Để trình chiếu, em nhấn phím:          
	A. F2         
	B. F1
	C. F12
	D. F5


B. THỰC HÀNH (6 điểm ) 
Câu B.1: (3 điểm) Khởi động phần mềm Word, soạn thảo theo mẫu sau:

ĐỂ CÓ SỨC KHỎE TỐT

Sức khỏe có vai trò vô cùng quan trọng đối với chúng ta. Để có được một sức khỏe tốt không phải là điều khó khăn mà nó nằm trong sự lựa chọn của mỗi người.


Hãy luyện tập thể thao ngay từ bây giờ, bạn sẽ có một sức khỏe tốt, một tinh thần thoải mái hơn và khi có sức khỏe và tinh thần thoải mái bạn sẽ làm được điều mà mình mong muốn.









Nguồn Internet

Yêu cầu:


+ Soạn thảo và trình bày.

- Tên đề bài viết hoa, toàn bộ bài phông chữ Times New Roman, cỡ chữ 14

- Dãn dòng 1.5

- Đoạn văn căn đều hai bên, đầu đoạn thụt vào.

+ Lưu vào thư mục của mình tên: Bài 1 kỳ 1

Câu B.2: (3 điểm): Tạo một bài trình chiếu gồm 3 Slide, các Slide được chèn các thông số (số trang, ngày tháng năm), tạo hiệu ứng cho từng đối tượng. 

- Slide 1: Tiêu đề nói về "Thầy (cô) giáo mà em yêu quý". 


Giới thiệu về tên, tuổi, hình dáng, tính tình

- Slide 2: Chèn hình ảnh loài hoa.
- Slide 3: Nêu cảm nghĩ của em về  thầy (cô) giáo mà em yêu quý.
+ Lưu bài trình chiếu vào thư mục của em với tên: Bai 2 ky 1

MA TRẬN BÀI KIỂM TRA CUỐI HỌC KỲ I

Môn: Tin học - Lớp 5
Năm học: 2020 – 2021
1. Ma trận số lượng câu hỏi và điểm.
	Mạch

 kiến thức – kỹ năng
	Số câu/ số điểm
	Mức 1
	Mức 2
	Mức 3
	Mức 4
	Tổng điểm và tỉ lệ %

	
	
	TN
	TL/

TH
	TN
	TL/

TH
	TN
	TL/

TH
	TN
	TL/

TH
	Tổng
	TL



	1. Khám phá máy tính
	Số câu
	2
	
	1
	
	
	
	
	
	3
	

	
	Số điểm
	1
	
	0,5
	
	
	
	
	
	1.5
	15%

	2. Soạn thảo văn bản
	Số câu
	2
	
	
	
	
	1
	
	
	3
	

	
	Số điểm
	1
	
	
	
	
	3
	
	
	4.0
	40%

	3. Thiết kế bài trình chiếu
	Số câu
	2
	
	1
	
	
	
	
	1
	4
	

	
	Số điểm
	1
	
	0.5
	
	
	
	
	3
	4.5
	45%

	Tổng
	Số câu
	6
	
	2
	
	
	1
	
	1
	10
	

	
	Số điểm
	3
	
	1
	
	
	3
	
	3
	10
	100%

	
	Tỉ lệ
	30%
	
	10%
	
	
	30%
	
	30%
	100%
	


2. Tương quan giữa lí thuyết và thực hành:
	
	Số câu
	Điểm
	Tỉ lệ

	Lí thuyết (20')
	8
	4
	40 %

	Thực hành (20')
	3
	6
	60 %


ĐÁP ÁN BÀI KIỂM TRA CUỐI HỌC KỲ I

Môn: Tin học - Khối 5

Năm học: 2019 - 2020

	Câu
	Đáp án
	Điểm

	A. Lý thuyết

	Câu 1
	B
	0.5 điểm

	Câu 2
	C
	0.5 điểm

	Câu 3
	A
	0.5 điểm

	Câu 4
	B
	0.5 điểm

	Câu 5
	D
	0.5 điểm

	Câu 6
	B
	0.5 điểm

	Câu 7
	A
	0.5 điểm

	Câu 8
	D
	0.5 điểm

	B. Thực hành

	Câu B.1


	- Soạn thảo đúng phông chữ, cỡ chữ
	0.25 điểm

	
	- Dãn dòng 
	0.25 điểm

	
	- Căn đều hai bên, đầu đoạn thụt vào ô

	0.25 điểm

	
	- Lưu bài vào thư mục
	0.25 điểm

	
	- Soạn thảo đủ nội dung theo mẫu
	2 điểm

	Câu B.2
	- Soạn thảo được nội dung các Slide đúng với yêu cầu:

. Slide 1



. Slide 2



. Slide 3: 




	1 điểm

0.25 điểm

1 điểm

	
	- Tạo được hiệu ứng cho các đối tượng
	0.5 điểm

	
	-  Lưu được bài vào thư mục

	0. 25 điểm


Điểm





Nhận xét





Điểm





Nhận xét





Trường: Tiểu học Bình Lãng


Lớp: 4A


Vở: Tập làm văn


Họ và tên: Nguyễn Mai Phương


Năm học: 2020-2021





Điểm





Nhận xét
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